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® CONNECTING MEDIA

What is Content management?

Landscape by example

Media types

Available solutions

Digital asset management

Drupal 8 only
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® INTRO - Evolution

In Drupal 8 we evolved..
File

Contrib File Entity
Contrib Media

8.4 Media in Core
8.6 Media in Core with Library

YYVYVYY



https://dri.es/an-update-on-the-media-initiative-for-drupal-8-4-8-5

AREAS TO IMPROVE FOR
GPQ CONTENT

AUTHORS

Richer image &
media integration

Digital Asset
Management

Content approval

workflows 1 8%;5

Full site content

staging & preview 17%

Real-time

collaborative editing 11%

Content sharing M AUTHORS

between sites 11% ALL

The results of the State of Drupal 2016 survey show the importance of the
Media Initiative for content authors.


https://dri.es/state-of-drupal-presentation-may-2016

winLGn i, Home Articles Recipes

Super easy vegetarian pasta bake =
N
A wholesome pasta bake is the ultimate . -f""“"_
comfort food. This delicious bake is super-
quick to prepare and an ideal midweekmeal &
for all the-family. p

SKip the spirits with delicious mocktails

VIEW ARTICLE >

Fiery chili sauce Crema catalana
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® INTRO - Best practices

Experience from...

Module maintenance

Building distributions

Site Building

Custom development
Operation

Training, coaching, consulting

YYYVYVY




@® INTRO - Core 8.6 Status
Stable Sources
> Media > File
> Well supported > |Image
> Audio
Experimental > Video
> Library > Remote video
> minimal o Youtube
> |n transition o Vimeo

MOSYSTEMS



Media library X

Published Name Media type Sort by

- Any - [ 1[- Any - v | | Newest first v | Apply Filters

DRIESNOTE

Drupal Europe

Darmstadt,Germany
10 - 14 September 2018

2021 Calendar Drupal Europe DrupalCon Nashville 2... Druplicon

Select media



https://www.drupal.org/blog/drupal-8-6-0

BASICS
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® BASICS - What is Media?

> Away from Files

> Entity
o Source (type)
o Fields
« File, Filename, ID
« Entity Reference
= Remote identifier

MEDIA MEDIA

> Any type of media “content”
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® BASICS - Local VS Connected / Remote

> [OCAL
o Any type of Media inside Drupal

> CONNECTED / REMOTE

o Benefit from SaaS providers

o Specialized in a specific media type
o Qut of the box

o Remotely managed

> MIXED REALITY
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@® BASICS - Media Lifecycle

Upload

Processing

StorOge Original + Metadata
Placement

:Ormotting View modes / Derivatives
Delivery

YYYVYVY
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@® BASICS - Implications of Decoupling a provider

> Adds complexity

> Dependency

o Ownership
o Lock-in
o APl Changes

> Drupal Expectations
> Provide extra value
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® BASICS - Implications - User expectations

Needs
truly deep integrations

> Support expectations
> Through the lifecycle

> QOr experience limitations




> Availability - API
> Speed - Caching
> Accounts

o Authenticate

o Permissions
> Entity

o Types

o Fields
> Multilingual

> Revisioning
D

>

V'V

VYVY

MOSYSTEMS

@® BASICS - Implications - Drupal expectations

Views

o List - Paging

o Filter

Placement - Usage
View modes - formatter
o Responsive

Form modes - widgets
Image Derivatives
(Personalization)
(Content Moderation)



BY EXAMPLE



Products  Support  Community  About Demo

Nextcloud

INEWS) Nextcloud 14: Video verification, Signal/Telegram 2FA and morel >

Nextcloud -
Protecting your

i i
Building self-hosted products that allow you

to be productive without losing control - ( ) n

M Allfiles

2016 consol...json Dead..mp3 Nextc..al.pdf

Learn more | a
notes. txt el

5

veard...vcard

Download ~ Buy

Photos
Hummingbird
Documents
end-to-end

| awesome video

Nextcloud Manual

GDPR

(=R




> Authentication
o Global key
o Per-user key
> Less site building

YVYVY

> Many Challenges

MOSYSTEMS

® BY EXAMPLE - What if we connect Nextcloud

> Media Licensing Metadata

Browser

Extraction from assets
Thumbnail

Predefined metadata
structure
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® BY EXAMPLE - What if we connect Nextcloud

User specific permissions
Image derivative mapping
Cropping

Usage report

Metadata updates

YYVYVYY

Wish it was fully featured AND API first!




CONCEPTS



® CONCEPTS

MOSYSTEMS

Metadata replication

Usage tracking

Placement - WYSIWYG

Browsing

Expiration
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® CONCEPTS - Metadata replication

-ields based
Mapping configuration
Replicate on save

YVY

> Metadata Updates?

o (delta)
o Changes?
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® CONCEPTS - Placement

> WYSIWYG
> Field - Entity Reference Media
> Entity type - Paragraphs
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® CONCEPTS - Consistency

> Module: Linkit

o Managed link

« Stop alias based links that break!
o Matcher / Browser
o Patch: Field support

o 8.x:25,095 - August 26, 2018 - /.x:58,467
Total: 84,235



https://www.drupal.org/project/linkit
https://www.drupal.org/project/link_attributes/issues/2939514

Manage matchers 7~

Edit

Manage matchers Translate linkit profile

Home » Administration » Configuration » Content authoring » Linkit profiles » Edit Default profile

Matchers defines how different data can be queried and displayed in the autocomplete suggestion list. Multiple matchers of the same type can be
used at the same time to granulate the suggestions. The order of the added matchers defines in which order the suggestions will be presented.

MATCHERS

+ Content

+ Media

Show row weights

OPERATIONS

Metadata: by [node:author] | [node:created:medium]

Bundle filter: None ( . =0
Group by bundle: No EESE
Include unpublished: Yes

Metadata: by [media:author] | [media:created:medium] )
Bundle filter: Document | Edit v)
Group by bundle: No . '
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@® CONCEPTS - Usage tracking

> Module: Entity Usage

o Pluggable tracking
« Entity References
« Link field
« Entity Embed
« Linkit, ...
o 8x1,429 - August 26, 2018



https://www.drupal.org/project/entity_usage

Entity usage information for Nobis Secundum Sino 7~

View Edit Delete
Home » Nobis Secundum Sino
ENTITY
Foo bar page
Sample page created in CATALAN
Example page created in FRENCH
Ea Magna Paulatim

Persto Similis Venio

Usage

TYPE

Content

Content

Content

Content

Content

Devel

Translate

LANGUAGE
English
Catalan
French
English

English

FIELD NAME
Related pages
Related pages
Related pages

Related pages

Related pages

STATUS

Published

Published

Published

Published

Published



N
MOSYSTEMS

® CONCEPTS - Selection

> (Core 8.6
o Basic, hardcoded

> Module: Media Entity Browser

o Highly
« Extensible
« Configurable
o 8x:4,852 - August 26, 2018



https://www.drupal.org/project/media_entity_browser

Image library My images

Upload files Icon

Media name

Bundle Status Folder Tags

drupal-8-logo-padding.png

linux

19. January 2018, 10:39

drupal

19. January 2018, 10:30

Select images

Sort by

-Any- v|| True v||-Any- v‘]

Created

Apply

md-systems.svg

)SYSTEMS
19. January 2018, 10:24

newspaper-o

O
—
—

A —

29. December 2017, 16:56

pexels-photo-324658-bw.jpeg
T =wa

A 4

admin
4. December 2017, 17:26

User

1. December 2017, 16:35

file-pdf-o

Jis

14. August 2017, 17:55

user-times

=X

26. June 2017, 18:43

Order
v|| Desc v

pencil-square-o
-\l

T4

26. June 2017, 18:29

()

26. June 2017, 18:26

Layout
o o
aee
aee

21. june 2017, 15:10
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® CONCEPTS - Upload

> (Core)
> Module: DropzonedS

o 8.x18,219 - August 26, 2018
o Client side image resize



https://www.drupal.org/project/dropzonejs
https://www.dropzonejs.com/

Select hero image

Image library My images Upload files

File upload *

Drag and drop images here to upload

or

Select files
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® CONCEPTS - Expiration

> Module: Media Expire

o Part of Thunder
o 8x:810 - August 26, 2018



https://www.drupal.org/project/media_expire

MEDIA TYPE GROUPS



MOSYSTEMS
® TYPES - Picture
> JPG, PNG, GIF > |mage toolkit
> Tag <img src o GD
> Tag <figure> <img /> o Imagemagick
<figcaption /> > |mage effect
> |mage styles o Cropping
o derivatives o Other Effects
> Responsive img styles > Image
> |Lazy Loading
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@® TYPES - Picture - Cropping Modules

> Module: Crop AP

o 8x:28,047 - August 26, 2018
> Module: Focal Point

> Module: Image Widget Crop

> Module: Automated Crop



https://www.drupal.org/project/crop
https://www.drupal.org/project/focal_point
https://www.drupal.org/project/image_widget_crop
https://www.drupal.org/project/automated_crop
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® TYPE - Picture - Lazyloading Modules

> Module: Blazy

o Image lazy loading
o 8x17,888 - August 26, 2018

> Module: Lazyloader

o 8.x:357 - August 26, 2018 - 7.x:3,890
Total:4,247



https://www.drupal.org/project/blazy
https://www.drupal.org/project/lazyloader
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® TYPE - Picture - Saas

> DAM - More Later

o Bynder
o Elvis

o ..
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® TYPE - Graphics

> SVG _&_
o Tag<img SVG

> |nline SVG

o Tag<svg
o CSS control
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® TYPE-Icons

> Module: Font Awesome lcons

o Font|SVG

o |con Browser

o Best Practice: Media bundle
« Entity Usage

> Module: FA Menu Icons



https://www.drupal.org/project/fontawesome
https://www.drupal.org/project/fontawesome_menu_icons
https://www.drupal.org/project/fontawesome_menu_icons
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® TYPE - Video

> Tag <video
> Core 8.5 Video

o Local storage

> (Core 8.6 Remote video
o oEmbed based
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® TYPE - Video - Players

> Module: Video.js

o HTML5 Video Player

o 8x909 - August 26, 2018 - /.x14,283
Total15,362

> Module: JWPlayer

o 8x:224 - August 26, 2018 - 7.x.3,856
Total:4,080



https://www.drupal.org/project/videojs
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® TYPE - Video - Saas

> Module: Video Embed

O

Field

Reference

Metadata fetch / update
Youtube, Vimeo, more

8.x:40,715 - August 26, 2018 - 7.x.:62,472

Total103,187
e

O O O O O



https://www.drupal.org/project/video_embed_field
https://www.drupal.org/project/video_embed_html5
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® TYPE - Video - Saas

> Module: Brightcove

o 8x:240 - August 26, 2018 - 7.x:2,009
Total: 2,281



https://www.drupal.org/project/brightcove
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® TYPE - Audio

Core 8.6 local

Tag <audio

Local audio

(Module: Remote audio)

YV VY
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® TYPE - Audio SaaS

> Module: Soundcloud

o Feature: Field

o 8.x:735 - August 26, 2018 - 7.x.3,6/8
Total:4,432



https://www.drupal.org/project/soundcloudfield

MOSYSTEMS

‘ GALLERY PARADOXON
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® GALLERY PARADOXON

Select your flavor..
> Multivalue field
> Media type

> (Content type

> Paragraph
> (Paragraph library)
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® GALLERY Module Slick

> Module; Slick

o “the last carousel you'll ever need”

o 8x15,204 - August 26, 2018 - 7.x:.23,802
Total 39,006



https://www.drupal.org/project/slick
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® GALLERY Module Flex Slider

> Module: Flex Slider

o 8x:5,785 - August 26, 2018 - /.x109,748
Total 115,533



https://www.drupal.org/project/flexslider
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® TYPE - Social

Twitter
> Module: Media Entity Twitter

o Link field
o Formatter; Twitter embed
o 8x5,761- August 26, 2018



https://www.drupal.org/project/media_entity_twitter

.
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® TYPE - Social

Instagram
> Module: Media Entity Instagram

o Link field
o Formatter: Instagram embed
o 8x:5,585 - August 26, 2018



https://www.drupal.org/project/media_entity_instagram
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® TYPE - Maps

> Google Maps
o Module: Simple Google Maps

Many more...



https://www.drupal.org/project/simple_gmap
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® TYPE - Polls

> Core Module Poll
> Riddle Marketplace

o “Quizzes”
o Part of Thunder



https://www.drupal.org/project/riddle_marketplace
https://www.riddle.com/
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® TYPE - Interaction

> Module: H5P H‘-P

o “Create and Share Rich Content and
Applications™

o 8.x:694 - August 26, 2018 - 7.x:3,735
Total: 4,435



https://www.drupal.org/project/h5p

® Interactive Video Editor
X Upload video & Add interactions i= Summary task

@ T e v =

rag to place image

Fill in the correct berries

Strawberries and berries

are mixed with and

oatmeal to make this

delicious smoothie.

@& Show solutions

Insert the missing words in this text about berries found in Norwegian forests and mountainous regions.

Bilberries (Vaccinium myrtillus), also known as | blue ¥ berries are edible, nearly black berries found in nutrient-

poor soils.

Rasp

blackberries found in alpine and arctic tundra.

X Cloudberries (Rubus chamaemorus) are edible orange berries similar to raspberries or

Redcurrant (Ribes rubrum) are red translucent berries with a diameter of 8-10 mm, and are closely related to its black

colored relative | black ¥ currant.

@ You got 2 of 3 blanks correct. C' Tryagain
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® TYPE - Generic widgets

oEmbed
> Module: Simple oEmbed

o 8.x:25 - August 26, 2018 - /.x:332
Total:357

> (COI’@ - only base class )

> QOthers?



https://www.drupal.org/project/soembed
https://oembed.com/
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® TYPE-HTML

> Tag <iframe, <script
> Text field
o Text format “code” without WYSIWYG
> Any widget provider
> Example: Typeform

O

o “Turning data collection into an experience”



https://www.typeform.com/




MNDSYSTEMS
® CONCEPTS

Storage

Asset separation

Infrastructure
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® STACK - Storage - Module: Flysystem

FEATURES

> “8'X:683” - August 26, 2018 > Ftp (Requires ftp extension)

b elele] > Sftp

> Stream wrapper > Dropbox

© pOth based magic > Zip (through ZipArchive)

> Rackspace Cloud Files
> Amazon Web Services - S3
> QOpenstack Swift

Example path: 'local-example://path/to/folder


https://www.drupal.org/project/flysystem
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® STACK - Storage

> Module: S3 File System

o 8x1,592 - August 26, 2018 - 7.x:3,285
> Module: Remote stream wrapper

o 8x126 - August 26, 2018



https://www.drupal.org/project/s3fs
https://www.drupal.org/project/remote_stream_wrapper_widget
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@® STACK - Asset separation

> Module;: CDN

> Asset domain
> “Origin Pull” CDNs = transparent



https://www.drupal.org/project/cdn

N
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® STACK - Infrastructure

> DNS

o Https termination / certificate

o Example: CloudFlare
m |Image optimization
m No bandwidth cost

o Can be used with a subdomain
« CDN

> Mount driver




DIGITAL ASSET

MANAGEMENT
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® DAM - Elvis

> Module: Media Elvis Rﬁ.c V

o Woodwing Elvis somedia
3.z =
> Basic integration CONPUTERSYSTENE
o Local delivery o Paging
o Media contrib o Folder filter
o Images only o Metadata mapping
o Full text search o Thunder integration



https://www.drupal.org/project/media_elvis
https://www.woodwing.com/en/digital-asset-management-system

Digital Asset Management

In today's publishing and digital marketing world you need to create the right visuals fast.
And whether it's a unique editorial image, a banner ad for a new campaign or the latest
product shots, it needs to be beautiful, on-brand and useable for any channel.

| t t laborat )
I S Creatives Oll rate mo

ou maximum control over when and




Select entities

Elvis Media Select existing

SEARCH

Keyword

A single word such as "hello" or a

surrounded by double quotes such a

Search Clear

Downhlll MTB WM 2018-
Lenzerheide
1600 x 1067 px

Downhill-MTB WM-2018-
Lenzerheide
1600 x 1067 px

Import image

a group of words

"hello world".

Downhill-MTB WM-2018-
Lenzerheide
1600 x 1067 px

Downhlll MTB WM- 2018~
Lenzerheide
1600 x 1067 px

FOLDERS

- None -

Downhill-MTB WM-2018-

Lenzerheide
1600 x 1067 px

Downhlll MTB WM 2018-
Lenzerheide
1600 x 1067 px

Downhill-MTB WM-2018-
Lenzerheide
1600 X 1067 px

Downhill-MTB WM-2018-

Lenzerheide
1600 x 1067 px

T

Downhlll MTB WM- 2018-

Downhill-MTB WM-2018-

Pe—7 T

- - ‘.
Downhill-MTB WM-2018-

Downhill-MTB WM-2018-




Q@ Home = Manage § admin

* Configuration }l People .|| Reports

(.', B content h Structure '1\ Appearance ﬁc Extend

Manage fields

Edit Manage fields Manage form display Manage display

Home » Administration » Structure » Media bundles » Edit Elvis media image

+Add field

LABEL MACHINE NAME FIELD TYPE OPERATIONS
Copyright field_copyright Text (plain) Edit v
Description field_description Text (formatted, long) Edit v
Elvis remote id field_elvis_remote_id Text (plain) Edit v
Image field_image Image Edit -

Tags field_tags Entity reference Edit v




Edit Elvis media image media bundle

Edit

Manage form display Manage display

Home » Administration » Structure » Media bundles

Label *
Elvis media image Machine name: elvis_media_image

The human-readable name of this media bundle

Description

Describe this media bundle. The text will be displayed on the Add new media page.
Type provider

Elvis Media Image v

Media type provider plugin that is responsible for additional logic related to this media

TYPE PROVIDER CONFIGURATION

Field with source information
Image v

Field on media entity that stores Image file. You can create a bundle without selecting a value for this dropdown initially. This dropdown can be populated after adding fields to the bundle

FIELD MAPPING
Description

Description v
Remote ID

Elvis remoteid v

Title

- Skip field - v
Name

Media name v
Filename

- Skip field - v
Asset path

- Skip field - v
Tags

Tags x:

Copyright owner

Copyright v
Width

- Skip field - v
Height

- Skip field - v




Edit Elvis media image ATHERTON Rachel_Downhill_Elite_Woman_WM_by Piotr_Staron IMG_6830.jpg

View Edit Delete

Home » ATHERTON Rachel_Downhill_Elite_Woman_WM_by_Piotr_Staron IMG_6830.jpg

Media name *

ATHERTON Rachel_Downhill_Elite_Woman_WM_by_Piotr_Staron IMG_6830.jpt
The name of this media
Copyright

Verein Bike Weltcup

Image

wg‘\Pr'ewew
Alternative text
UCI Mountain BIVKE World Championships, 5.-9. September 2018, Lenzerheid
This text will be used by screen readers, search engines, or when the image cannot be loaded
Title
Downhill-MTB WM-2018-Lenzerheide
The title is used as a tool tip when the user hovers the mouse over the image
[2) ATHERTON%2520Rachel_Downhill_Elite_Woman_WM_by_Piotr_Staron%2520IMG_6830_preview.jpg (134.78 KB) Remove
Tags
¥ Bike
¢! Bike World Championships
¥l Events
Familie
Langlauf
Planoiras
¥/ Sommer
Wandern

Winter

Description

B I| =

99 [d || Format ~ || [ Source

UCI Mountain Bike World Championships, 5.-9. September 2018, Lenzerheide, Downhill



MOSYSTEMS

® DAM - Bynder

> Module: Bynder

> Unique features



https://www.drupal.org/project/bynder

> Remote delivery

> Per-user
o Authentication
o Search facets
o Access

> Usage restrictions
o Indication
o Review tab
o License info

VYVVYVY

VYV

MOSYSTEMS

® DAM - Bynder - Unique features

Bynder formatter

Image, Video, Documents
Derivatives mapping

AP| Caching - speed
Direct Upload

o Batch processing
Updates (Cron)

Demo module

Lightning integration



FIELD MAPPING

Description

Description v
Name

Media name v
Tags

- Skip field - v
Type

Type v
Video preview urls

- Skip field - v
Thumbnail urls

- Skip field - v
Width

- Skip field - v
Height

- Skip field - v

Date created
- Skip field - v

Data modified
- Skip field - v

¥ MEDIA

Bynder » Bynder digital asset management system integration.

Bynder demo » Demonstration of the Bynder integration.

APl CONNECTION TEST

The API connection was established successfully.

Test connection

¥| Test connection before saving

Uncheck to allow saving credentials even if connection to Bynder can't be established.

BYNDER IMAGE DERIVATIVES
e mini
e webimage
e thul
Reload derivatives info

Bynder provides "mini", "webimage" and "thul" image sizes by default. Custom derivatives can be configured to better suit specific
use-cases. Reload of derivatives can be triggered if any derivatives are missing from the list.



USAGE RESTRICTION METADATA

Usage restrictions v

Select metaproperty which is responsible for usage restriction. This is used to limit what assets can be used. If the information is not provided we assume royalty free.

Royalty free restriction level *
Royalty free w

Select metaproperty option for assets that can be used everywhere.

Web license restriction level *
Web only v

Select metaproperty option for the assets that may be used only online.

Print license restriction level *

Printonly +

Select metaproperty option for the assets that may be used only for print.




Select assets

Bynder Upload

Search keyword

Search

DSC_0081.JPG

(image)

Option Option 3 Option 4
-None- | -None- | -None-

DSC_0107.JPG DSC_0108.JPG

(image) (image)

s

DSC _0108.JPG
image

DSC_0054.JPG
mage

DSC_0194.JPG

(image)

DSC_0069.JPG
image




Select assets

Bynder Upload

File upload

Drop files here to upload them

Description

Description text that should be added to assets.

Upload assets




bynder usage

View Edit Delete Bynder media usage

T T

DSC_0054.JPG image Royality free Edit =

Edit on Bynder
bitcoin_on_keyboard-100572325-primary.idge_.jpg image N/A EQIT ¥

Usage info is not available yet. Usage
restriction level: Royality free




Edit Bynder example What Is bitcoin?

Published
Last sared

Suady (54 Rasthor wi

¥ Créate e

I =
Bepinian hag wairage

VL PATH SETTINGS
AUTHOMMNG NP ORMATION
PROMOTION OFTIONS

Peut ferman Qe I

MEOM ASsaYS

Seloct anrets




Edit Bynder example What is bitcoin?

“%
X
&
A oo e . b Published
I 4 Last saved RO2201)  J1a
Sady (10 wtvomary) AEhor: »3
h O Bl » - " o ¥ Creste .
Revision dag message
LU ' »

URA PATH METTINGS
AUTHORING WP ORMATION

PROMOITION OFTIONS

Toxt formet  Sasc WA

MEDIA ASSETS

Select asvels

ve and keep publinhed - Previaw



CONTENT



I
MOSYSTEMS

® CONTENT - Repository

> When all content becomes “media”

Modules Presentations
> Contentpool > TUE 11:30 3.03
> Drupal Content Sync > THU 1410 2.07
> Deploy

> Contenta CMS
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